CDS-G3 Diagnostic Software Orientation
Notice to Users of This Manual

Throughout this publication, dangers, warnings, cautions, and notices (accompanied by the International HAZARD Symbol ⚠️) are used to alert the mechanic to special instructions concerning a particular service or operation that may be hazardous if performed incorrectly or carelessly. Observe them carefully!

These safety alerts alone cannot eliminate the hazards that they signal. Strict compliance to these special instructions when performing the service, plus common sense operation, are major accident prevention measures.

⚠️ DANGER
Indicates a hazardous situation which, if not avoided, will result in death or serious injury.

⚠️ WARNING
Indicates a hazardous situation which, if not avoided, could result in death or serious injury.

⚠️ CAUTION
Indicates a hazardous situation which, if not avoided, could result in minor or moderate injury.

NOTICE
Indicates a situation which, if not avoided, could result in engine or major component failure.

IMPORTANT: Identifies information essential to the successful completion of the task.

NOTE: Indicates information that helps in the understanding of a particular step or action.

This manual has been written and published by the Service Department of Mercury Marine to aid our dealers' mechanics and company service personnel when servicing the products described herein. We reserve the right to make changes to this manual without prior notification.

Alpha, Axius, Bravo One, Bravo Two, Bravo Three, Circle M with Waves Logo, K-planes, Mariner, Mercathode, Mercruiser, Mercury, Mercury with Waves Logo, Mercury Marine, Mercury Precision Parts, Mercury Propellers, Mercury Racing, MotorGuide, OptiMax, Quicksilver, SeaCore, Skyhook, SmartCraft, Sport-Jet, Verado, VesselView, Zero Effort, Zeus, and #1 On the Water are registered trademarks of Brunswick Corporation. Mercury Product Protection is a registered service mark of Brunswick Corporation.

It is assumed that these personnel are familiar with marine product servicing procedures. Furthermore, it is assumed that they have been trained in the recommended service procedures of Mercury Marine Power Products, including the use of mechanics’ common hand tools and the special Mercury Marine or recommended tools from other suppliers.

We could not possibly know of and advise the marine trade of all conceivable procedures and of the possible hazards and/or results of each method. Therefore, anyone who uses a service procedure and/or tool, which is not recommended by the manufacturer, first must completely satisfy himself that neither his nor the products safety will be endangered.

All information, illustrations, and specifications contained in this manual are based on the latest product information available at the time of publication. As required, revisions to this manual will be sent to all dealers contracted by us to sell and/or service these products.

Refer to dealer service bulletins, operation maintenance and warranty manuals, and installation manuals for other pertinent information concerning the products described in this manual.
Precautions

It should be kept in mind, while working on the product, that the electrical and ignition systems are capable of violent and damaging short circuits or severe electrical shocks. When performing any work where electrical terminals could possibly be grounded or touched by the mechanic, the battery cables should be disconnected at the battery.

Any time the intake or exhaust openings are exposed during service they should be covered to protect against accidental entrance of foreign material into the cylinders which could cause extensive internal damage when the engine is started.

During any maintenance procedure, replacement fasteners must have the same measurements and strength as those removed. Numbers on the heads of the metric bolts and on the surfaces of metric nuts indicate their strength. American bolts use radial lines for this purpose, while most American nuts do not have strength markings. Mismatched or incorrect fasteners can result in damage or malfunction, or possibly personal injury. Therefore, fasteners removed should be saved for reuse in the same locations whenever possible. Where the fasteners are not satisfactory for reuse, care should be taken to select a replacement that matches the original.

Replacement Parts

Use of parts other than the recommended service replacement parts will void the warranty on those parts that are damaged as a result.

<table>
<thead>
<tr>
<th>WARNING</th>
</tr>
</thead>
<tbody>
<tr>
<td>Avoid fire or explosion hazard. Electrical, ignition, and fuel system components on Mercury Marine products comply with federal and international standards to minimize risk of fire or explosion. Do not use replacement electrical or fuel system components that do not comply with these standards. When servicing the electrical and fuel systems, properly install and tighten all components.</td>
</tr>
</tbody>
</table>

Cleanliness and Care of Product

A Mercury Marine Power Product is a combination of many machined, honed, polished, and lapped surfaces with tolerances measured in the ten thousands of an inch/mm. When any product component is serviced, care and cleanliness are important. It should be understood that proper cleaning and protection of machined surfaces and friction areas is a part of the repair procedure. This is considered standard shop practice even if not specifically stated.

Whenever components are removed for service, they should be retained in order. At the time of installation, they should be installed in the same locations and with the same mating surfaces as when removed.

Personnel should not work on or under an engine that is suspended. Engines should be attached to work stands, or lowered to ground as soon as possible.
Manual Outline

Section 1 - Introduction
   A - Introduction

Section 2 - Licensing and Registration
   A - Licensing and Registration

Section 3 - Hardware
   A - Hardware

Section 4 - New Features
   A - New Features

Section 5 - Becoming Familiar with the CDS G3 Program
   A - Becoming Familiar with the CDS G3 Program

Section 6 - Frequently Asked Questions
   A - Frequently Asked Questions

Section 7 - Appendix
   A - Appendix
## Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>What is CDS G3?</td>
<td>2</td>
</tr>
<tr>
<td>CDS G3 Support</td>
<td>2</td>
</tr>
<tr>
<td>Installation</td>
<td>2</td>
</tr>
<tr>
<td>Administrative Rights</td>
<td>2</td>
</tr>
<tr>
<td>Computer Requirements</td>
<td>2</td>
</tr>
<tr>
<td>PC Minimum Hardware Specifications</td>
<td>2</td>
</tr>
<tr>
<td>Recommended Computer Specifications</td>
<td>3</td>
</tr>
<tr>
<td>Operating System Requirements</td>
<td>3</td>
</tr>
</tbody>
</table>
What is CDS G3?

CDS G3 is a standalone PC-based program that complements the original Mercury Computer Diagnostic System (CDS) by providing diagnostic support for select engines and Mercury Joystick Piloting systems. Additionally, all configuration functions necessary for preparing these systems for delivery are supported. CDS G3 allows for CAN-based multiple-processor communication through a clean, easy-to-navigate interface.

CDS G3 Support

Mercury Marine will provide support for the CDS G3 program and hardware. Any issues determined to be outside of the CDS G3 program or hardware will be the responsibility of the user. For support with CDS G3, contact Mercury Marine Technical Service at 920-929-5884 or on the internet at service.mercurymarine.com

Installation

Any installation disc for CDS G3 may be installed without a previous version of the software installed. Before proceeding with installation, complete all High Priority Updates as provided by Microsoft through Windows Update.

If updating CDS G3 from version 1.0, uninstall the software prior to installing the current version. If updating from CDS G3 version 1.1 or later, uninstallation is not required.

To install CDS G3, insert the installation disc into the disc drive of the computer. If the software installation does not start automatically, navigate to your optical drive and run setup.exe. This will most commonly be D: \issetup.exe. During installation, the following programs will be installed:

- Microsoft® ReportViewer 2010
- Microsoft Visual C++ 2010 SP1 Redistributable Package (x86)
- Microsoft .NET Framework 4.0 Client
- Windows Installer 4.5
- Kvaser® 4.9 CAN Adapter Driver

These additional programs are required for CDS G3 to deliver a rich, interactive user experience.

When the Literature feature is installed, CDS G3 will also install IIS Express 8.0, Microsoft .NET Framework 4.5.1, and Microsoft Internet Explorer 11.

Administrative Rights

The user performing the CDS G3 program installation must have administrative rights. If the computer has an MCDS user account, that user account was given administrative rights when it was created by an earlier CDS installation.

**NOTE:** Some information technology (IT) departments may restrict user rights for these accounts. If this has occurred, either the IT department must perform the installation, or they must grant administrative rights to the user accounts performing the installation.

Computer Requirements

The following specifications are established to support both CDS and CDS G3. Minimum and recommended specifications are listed following. Please adhere to the minimum specifications when upgrading CDS G3 on an existing computer. The recommended specifications have been established to provide a guideline for both best experiences and what we suggest when purchasing a new computer.

**PC Minimum Hardware Specifications**

- 1.2 GHz multi-core processor (dual core or better)
- 1024 x 768 screen resolution
- 10.1 in. screen size
- 2 GB RAM
- 120 GB hard drive
- 802.11 b/g/n wireless or 10/100 Ethernet
- DVD ROM optical drive (an external USB DVD drive is acceptable)
- Three USB 2.0 ports to accommodate CDS USB components. Alternatively, a single USB port and a USB port hub may be used.
Optional 9-pin serial port (The serial port is no longer required, but is still preferred. The use for a serial port is for CDS only.)

**Recommended Computer Specifications**

- Intel® i5 processor, 2.4 GHz or better
- 8 GB RAM
- 128 GB solid-state drive
- 802.11n+ wireless connection
- External DVD drive
- Three USB 2.0 ports to accommodate CDS USB components. Alternatively, a single USB port and a USB port hub may be used.

**Operating System Requirements**

We only support Windows® 7 Service Pack 1 Professional and Windows 8.1 Professional for use with CDS G3. While Windows XP Professional and Windows 8 Professional continues to work with CDS G3, these operating systems do not support Internet Explorer 11, which is required for the new Literature feature. To fully utilize CDS G3 1.6 and above, use it on Windows 7 Service Pack 1 Professional, Windows 8.1 Professional, or higher operating systems.
# Licensing and Registration

## Section 2A - Licensing and Registration

### Table of Contents

<table>
<thead>
<tr>
<th>Topic</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Licensing</td>
<td>2</td>
</tr>
<tr>
<td>Registration</td>
<td>2</td>
</tr>
<tr>
<td>CDS G3 Version Number</td>
<td>4</td>
</tr>
<tr>
<td>CDS G3 Updates</td>
<td>5</td>
</tr>
</tbody>
</table>
Licensing

For each copy of CDS G3 (kit or upgrade disc) purchased, a license will be issued to the dealer account number making the purchase. This license is limited to one per computer. If you desire to use CDS G3 on more than one computer, you will need an additional license for each computer. In this case we recommend purchasing a second kit because the hardware included in the kit is required for full functionality. When considering a second kit, keep in mind that to update minor revisions (example 1.4 to 1.5), you will need to purchase an update disc (license) for each installation.

CDS G3 licensing is not transferable between dealer numbers. We do recognize and respect the need to transfer your CDS G3 license between PC’s within your business for issues such as hardware failure or computer upgrades. If such an issue should arise, please contact the Mercury Marine Service Department to submit this request. We will only allow transfer of the current version of software. If you are using a previous version, please purchase the current version and install on the new PC.

The CDS G3 licensing agreement is presented for review and acceptance during installation. This document can also be accessed after installation in the start menu. The location is: Start»Mercury Marine»End User License Agreement.

Review this document for further details.

Registration

Two options are available when registering CDS G3 software: a 15-day trial registration or a standard registration. The trial mode will provide all functionality except for the ability to reflash. When the trial period expires, the software is disabled until registration is completed. When CDS G3 is registered, validation will be required every 45 days. To register and validate, internet access is required. Software registration may be revalidated at any time to restart the 45-day validation period. Once the 45-day validation period has expired, the software will be disabled until validation is completed.

When the CDS G3 software is started, you will be taken to the registration screen and prompted for your dealer number and phone number.
Enter your dealer number and phone number. The phone number to be used is the main phone number on record with Mercury Marine. Please enter this information with using only numbers and no other characters, as shown in the illustration to the right.

Once you click on Register, you will see the following screens:
CDS G3 Version Number

CDS G3 versions are defined by a version number. The example below shows version 1.6.0. The version number will define three parts of the version: a major version, a minor version, and a build number. The image below is from the CDS G3 startup splash screen, along with a description of the version number.

1 indicates the major version number, 6 indicates the minor version number, 0 indicates the build release number.
The complete version number can be noted from the splash screen, as shown above, or by selecting Help»About from the menu at the top of the screen. You will then see the following screen.

![About screen](image)

**About screen**

The major version number will designate drastic changes to the software.

We currently have not changed this number since the introduction of the CDS G3 software. The minor version number designates considerable changes in the software, usually requiring us to issue a new installation disc. Typically this update will introduce new functionality and address major issues.

The build version number designates small changes in the software. Typically we provide new eBOM’s (electronic bill of material), minor bug fixes, and provide slight product improvements. These updates are acquired within the CDS G3 program and are included with your minor version.

Licenses are limited to a minor version, and each minor version is licensed separately. If you have purchased a copy of 1.6, you are licensed for this and all builds within 1.6. What this means is when you purchase version 1.6.4, for example, you are entitled to all updates from 1.6.0 (the version installed from the 1.6 installation disc) through the current, latest version.

**CDS G3 Updates**

CDS G3 updates are provided in two ways, one for the minor versions, and one for the build. To acquire the minor version of our software, you will purchase either a CDS G3 kit (includes current software), or an upgrade disc. The installation disc is a full installation, so previous versions are not required. Also if you have a previous version installed, you can install an update without uninstalling the previous version. Once installed and registered, you can apply build updates available to your version to reach the most current version.

Build updates are downloaded from within the CDS G3 software. As long as the computer has internet access when the CDS G3 software is started, it will automatically check for available updates. If updates are available, you will be notified on the home screen. The update process can also be manually initiated by selecting Tools and G3 Updates from the upper menu.
# Hardware

## Section 3A - Hardware

### Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>Requirements</td>
<td>2</td>
</tr>
<tr>
<td>SmartCraft Interface Cable</td>
<td>3</td>
</tr>
<tr>
<td>CDS G3 Harness Connections</td>
<td>3</td>
</tr>
<tr>
<td>Vessels with a Junction Box</td>
<td>3</td>
</tr>
<tr>
<td>Vessels without a Junction Box</td>
<td>4</td>
</tr>
</tbody>
</table>
Requirements

CDS G3 requires the following hardware:

898289T81—SmartCraft Interface Cable (USB to DB9) (contains 879365022)

898289T83—CAN P and H adapter (DB9 to 10-pin CAN) (contains 8M0044023)

This harness functions only as an adapter between a DB9 and SmartCraft CAN connector
- CAN adapter cable
- Connects to SmartCraft interface cable DB9
- Connects to engine or J-box CAN connector

8M0046081—Harness adapter w/resistors (10-pin CAN to 10-pin CAN)

Required to replace a termination resistor when one is removed to gain access to the CAN bus
- Engine connection (note the Engine tag)
- Termination resistor end (note yellow tag)
All of the components above are included in the CDS G3 kit, part number 8M0098656. This kit will also include a disc containing the current version of the CDS G3 software at the time of purchase. When interfacing your CDS G3 diagnostic tool to the CAN bus, proper termination must be maintained. If you are gaining access to the CAN bus by removing a termination resistor, you must use the 8M0046081 adapter harness. If you are accessing the CAN bus through an open J-box port, 8M0046081 will not be used. More details on proper connection are detailed in the section, CDS G3 Harness Connections.

SmartCraft Interface Cable

The SmartCraft interface cable is a diagnostic interface to provide the ability for CDS G3 to communicate on Mercury CAN bus networks. Some features of the SmartCraft interface cable are:

1. Ruggedized
2. 2 channel (CAN P/H)
3. USB-to-DB9 interface
4. Powered from the PC, not the engine

The SmartCraft interface cable has three LED lights: one green power LED and two orange CAN bus LEDs. The power LED will illuminate solid green to indicate it is functioning correctly. This LED will flash if it has an issue. If this is encountered, most likely the device driver is not installed properly. Corrective action for this condition is documented in the Appendix.

When the SmartCraft interface is properly connected to both an engine and the diagnostic computer, there will be a solid orange LED on the appropriate BUS indicator on the interface (BUS 1 and/or BUS 2). This LED will flicker with communication. Any noncommunicating BUS channels will be indicated with an occasional illumination of the associated orange LED. Similarly, the CAN P/CAN H button in the CDS G3 software would be red or yellow to indicate no communication and green to indicate communication.

CDS G3 Harness Connections

Vessels with a Junction Box

1. Insert the SmartCraft Diagnostic Interface USB connector into a powered USB port.
2. Connect the SmartCraft Diagnostic Interface DB9 connector to the CAN P/CAN H adapter harness DB9 connector.
3. Connect the CAN P/CAN H adapter harness to the junction box to communicate with the power package.
IMPORTANT: Ensure that the correct termination resistor is installed on the CAN P bus. The CAN P bus must be properly terminated for the tool to communicate reliably. Improper termination will result in communication errors or complete loss of communication.

<table>
<thead>
<tr>
<th></th>
<th>Description</th>
</tr>
</thead>
<tbody>
<tr>
<td>a</td>
<td>SmartCraft interface cable</td>
</tr>
<tr>
<td>b</td>
<td>CAN P and H adapter</td>
</tr>
<tr>
<td>c</td>
<td>Harness adapter with resistor</td>
</tr>
<tr>
<td>d</td>
<td>Connect to engine or J-box connection</td>
</tr>
<tr>
<td>e</td>
<td>Connect to key f of CAN P and H adapter</td>
</tr>
<tr>
<td>f</td>
<td>Connects to e</td>
</tr>
<tr>
<td>g</td>
<td>Connects to h</td>
</tr>
<tr>
<td>h</td>
<td>Connects to g</td>
</tr>
<tr>
<td>i</td>
<td>Connects to computer USB port</td>
</tr>
</tbody>
</table>

**Junction box connection**

**Vessels without a Junction Box**

1. Insert the SmartCraft Diagnostic Interface USB connector into a powered USB port.
2. Connect the SmartCraft Diagnostic Interface DB9 connector to the CAN P/CAN H adapter harness DB9 connector.
3. Remove the CAN P termination resistor from the engine harness.
IMPORTANT: Ensure that the correct termination resistor is installed on the CAN P bus. The CAN P bus must be properly terminated for the tool to communicate reliably. Improper termination will result in communication errors or complete loss of communication.

4. Connect the CDS G3 harness adapter (84-8M0046081) to the CAN P/CAN H adapter harness, and connect the adapter harness to the engine harness connector.

CDS G3 typical engine connection (4.5L shown)

IMPORTANT: The CDS G3 harness adapter (84-8M0046081) contains the correct termination resistor for the SmartCraft Diagnostic Interface to communicate with the control module.
# Table of Contents

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>New Features Introduced in CDS G3 1.6.0</td>
<td>2</td>
</tr>
<tr>
<td>Graphing</td>
<td>2</td>
</tr>
<tr>
<td>Literature</td>
<td>2</td>
</tr>
</tbody>
</table>
New Features Introduced in CDS G3 1.6.0

With the release of CDS G3 1.6, we are excited to introduce two new features, graphing and literature. These features have long been in development and are now ready for integration into our software. The Graphing feature will allow eight data items to be graphed simultaneously, providing a graphical display of each item. The Literature feature will bring service literature to your access right in the CDS G3 program. We are very excited to present these two new tools and hope you find them useful.

Graphing

The Graphing feature is integrated into the Live Data section inside Module Data. When in Live Data, graphing can be initiated by selecting up to eight items by simply clicking on the box to the left of the item. The chosen items will then turn green and display a check in the box. As each is selected, the graphing tab will display the quantity of items chosen. Next, select the Graph tab. This will open the graphing interface and start to plot and graph the items previously chosen.

While using the graphing feature, there are several controls to enhance your use. On the right side of each graph is a tab, which will expand that specific graph to a full screen view. While in this full screen view, the additional controls will be available.

The triangles to the right can be dragged up and down to define upper and lower limits. Also on the left are + and – buttons to zoom in and out. The focus point of zoom is the middle of the graph. It is best practice to pan your graph to where you would desire before zooming. Above and below the zoom controls are up and down buttons to pan the chart. By selecting the shrink button in the lower right, the view will return to the previous screen, keeping the settings just made.

The gear icon in the graphing display will provide more shading options for your graph, along with logging customer information and resetting the graphs to their default settings. By providing customer information any recordings can be saved with this information pre-entered as the file name. At any time, while in either Live Data or Graphing, recording data can be initiated by clicking on the record button in the lower left. After a recording is made and saved, all the data is available to be replayed either in a data view or graphing view for further analysis.

Literature

A new service literature add-on has been introduced in CDS G3 version 1.6. To open literature, select the literature icon on the bottom right of the CDS G3 program, and a new interface will be launched.

When inside of the service literature feature, various service manuals will be able to be selected and used. In the initial launch, only the new 150 FourStroke manual will be available. We will make more literature available as we update our service literature to be compatible with this new platform.
When new literature becomes available, it will be displayed as available for download. Eventually we will also be providing service bulletins through the new literature feature.

Additional functions inside the literature feature include:

1. Create bookmarks to frequently used sections
2. Create your own mark ups, edits, and notes
3. Search within the service manual
Home Screen

The Home screen will report important information, including issues requiring attention. In the screen capture to the right, we are notified of a new software update, nine days are remaining on your CDS G3 registration, and no eBOM is selected. These issues should all be addressed for CDS G3 to function properly.

The Home screen will alert the technician to the available disc updates, internet updates and any current reflashes.

The Home screen will also display up to 3 items without selecting an eBOM. Those items are:

- Run hours
- Number of faults present
- Maintenance remaining

Registration Screen

Registration will be presented on any CDS G3 installation that has not completed the process. This screen is also accessible by selecting Tools » Registration. To register, an internet connection is required. Your full dealer number and full phone number are also required. Registration is required every 45 days, but can be performed at any time. Once completed, the 45-day registration period is reset.
**CAN Traffic**

The CAN button will let you know the communication status on CAN P and CAN H.

- **Red**—The computer is not connected to the SmartCraft Diagnostic Interface cable
- **Yellow**—The computer is communicating with the cable but no data is being received on the CAN bus.
- **Green**—The computer is communicating on the CAN bus.

*NOTE: CAN H will only turn green for models using CAN H. (Example: Outboard Joystick Piloting and Axius products)*

**Module Data Screen**

The **Module Data** screen allows the user to view data and engine faults. The selections in Module Data include:

- **Play Data**: Allows the user to open a recorded file (.bdr) from a previously recorded session and play back the data in raw format.
- **Record Data**: Allows the user to choose data items and record them to a file (.bdr).

*NOTE: Record data has been moved to the live data screen starting with version 1.6.

*NOTE: Only numerical items may be recorded at this time; this may not represent all of the items available via live data.*

- **Live Data**: Provides access to the data items for all modules.
- **View Faults**: This button is only available if faults are found on the engine. The red text in the info column indicates that the engine has faults.
- **Freeze Frame**: Provides access to memory buffers within the ECM. Freeze Frame buffers contain snapshots of data items at the time a fault occurs.
- **Run History**: Provides access to a runtime history map. Each time value is assigned to an RPM band. The RPM bands can be cleared but the total engine runtime will stay the same.
- **Maintenance**: Displays the current maintenance value, and provides access to resetting the maintenance percentage to 100%.
- **Reload Modules**: Clears all modules in module data and restarts module discovery.
- **Clear All Module Faults**: Clears all faults present and rescans for faults.
Printing

A newer feature in CDS G3, introduced in version 1.5, is the ability to print data from Freeze Frame, Faults, and Run History. This feature provides the ability to create a clean, professional document in printed form, or a PDF document. Each of these screens will have a gear icon in the upper right corner to access the Print Page feature. This icon will not be available from View Faults or Freeze Frame if faults or freeze frame data are not present.

Another new print feature is the ability to create a full report. A full report will create a summary view, and include freeze frame, faults, and run history, along with the ability to include your full dealership information and your customer’s information.

A full report can be created by selecting File»Print Full Report, or pressing F12. Inside of the preview of a full report, a gear icon will be available to include or exclude dealer and customer information.

The customer’s information can be added directly in this menu when Add Customer Information is selected. This information will be available until the CDS G3 program is closed; it will then be removed. You may change this information at any time without closing the software by selecting the gear icon, Remove Customer Information, and again select the gear icon and Add Customer Information. The Add Customer Information window will open and allow you to change the content.

Dealer information is entered by completing Add or Edit Dealer Information as part of Registration. To enter or edit your dealer information, select Tools»Registration. If entered, your dealer information will be displayed here. Your dealer information will remain in the program, unless it is manually removed through the Add or Edit Dealer Information.

With the inclusion of these new print features, the Print Screen button in the main tool bar has been removed. You can still use the old print screen function by either selecting File»Print Screen, or pressing Ctrl+F12 to capture the current screen.

Live Data—Categories and Drag and Drop Sorting

The live data screen has undergone considerable changes intended to improve readability and ease of use. Along with improvements to the layout, all data items may be reordered by simply dragging and dropping the item in the desired location. This will allow you to bring focus to items of concern within the same view without having to scroll to view data items.

While working with some systems, the live data screen may now show two tabs. These tabs are categorized data list items: Engine and Catalyst. Data items specific to catalyst have been located in the catalyst category. When diagnosing a catalyst related issue, selecting the catalyst category will provide you with quick access to this data without having to filter through the full data list.
Gear Icon and More Options

As shown previously, there is now a gear icon on select screens. By clicking on this gear icon, more options for the specific feature will be shown.

eBOM

The eBOM (electronic bill of materials) screen displays the possible matches to the system the tool is connected to. CDS G3 has the ability to actually talk to each ECM/PCM that is connected in the boat via CAN P. It will report what ECM/PCM it has found by showing a match next to those particular eBOMs. Some boats can have multiple ECM/PCM's depending on the SmartCraft configuration and the number of engines. The technician will see the selected eBOM displayed at the top right of the screen when it has been selected. An eBOM must be selected in order for the Live Data, Faults, Freeze Frame, Record and Maintenance items to become active on the Module Data screen.

The eBOM Selection Helper has been implemented to assist the user when CDS G3 cannot resolve the selection of an eBOM.
Configuration

Configuration allows the user to access the helm-related configuration items, such as steering wheel, handles, and CAN pads.

**Helm Configuration** provides access to helm status and configuration tools required for the setup or repair of a DTS system. **IMPORTANT:** Helm Configuration can be done on any command module Version 72 and higher. The items within this section are as follows:

**Helm Setup** allows the user to configure a helm to make the control system fully operational. By following the helm setup wizard, the module ID is set as part of the process.
**Current Configuration:** This tab displays the current helm configuration status of the vessel. The information is presented in a matrix format that is configured in a manner that displays information relative to the back of a boat. Example: starboard on the right and port on the left. Some of the information provided in a matrix is the module's city ID, software version, and quantity of modules at that address.

**Assign City ID:** This tab allows the user to set the City ID's for each helm module. This is exercised by moving a handle that coincides with a module. By following this wizard, the module's City ID is set.

**NOTE:** After performing the Lever Adapt, the engine location will automatically be set to the correct location based on the City ID that was set for the Command Module's when the City ID's were assigned.

**Lever Adapt:** This tab allows the user to configure the lever through its range of operation so that the module can learn the positions of forward, neutral, reverse, and all detents.
**Steering Wheel Config:** This feature provides access to a tool that allows the user to set the center location of the steering wheel. The tool must see movement of the steering wheel for the value to be set. For example, if the steering wheel is already in the center position, move it left or right and back to center to set the value.

**Remote Joystick Configuration:** The Remote Joystick Configuration button provides access to a tool that allows the user to define the number of remote joysticks available on each helm. The number of helms will be displayed followed by the number of remote joysticks the helm can use and the number of joysticks that are enabled for the helm. This does not indicate a total number of joysticks on the vessel, but rather the number of joysticks accessible by each individual helm.

**CAN Pad Configuration:** CAN Pad Configuration provides access to Trackpad, Autopilot, and SMUX status and configuration tools required for setup or relocation within a SmartCraft system. The items within this section follow:
Trackpad Configuration: This feature allows the user to view and configure the trackpad on each helm. **Trackpad Configuration** displays the current trackpad configuration status of all helms, as well as information related to each trackpad. Trackpads that show in the grid with a black background are not configurable. If there is more than one trackpad at a single address, the trackpad in conflict will need to be reassigned to a new address. To identify a trackpad at a specific location with one in the grid, press a button on that trackpad and a cell in the grid will flash indicating its location.

**IMPORTANT:** To prevent potential conflicts with another module, this tool will not assign a trackpad to the address of D9.

**Restore Defaults:** This feature gives the option to assign all trackpads to their original City ID.

Autopilot Configuration: This displays the current autopilot pad configuration status of all helms, as well as information related to each autopilot. Autopilot pads that show in the grid with a black background are not configurable. If there is more than one autopilot at a single address, the autopilots in conflict will need to be reassigned to a new address. To identify an autopilot at a specific location with one in the grid, press a button on that autopilot and a cell in the grid will flash indicating its location.
Assign Trackpads: This feature provides the user a wizard for assigning autopilot pad addresses by helm. All configurable autopilot pads on a helm will flash.

**NOTE:** Autopilot pads on earlier Zeus and Axius models may not be configurable.

SMUX Configuration: SMUX Configuration allows the user to view and configure the SMUX on each helm. SMUX (smart multiplexing) refers to the rocker switches.

The Configuration tab displays the current SMUX configuration status of all helms, as well as information related to each SMUX. SMUX that show in the grid with a black background are not configurable. If there is more than one SMUX at a single address, the SMUX in conflict will need to be reassigned to a new address. To identify a SMUX at a specific location with one in the grid, press a button on that SMUX and a cell in the grid will flash indicating its location. The Assign SMUX tab provides the user a wizard for assigning SMUX addresses by helm. All configurable SMUX on a helm will flash.

Drive Configuration: Drive Configuration provides access to a tool required for the setup or repair of a DTS system. The items within this section follow:

**NOTE:** Drive Configuration is used for Joystick Piloting/Axius systems only.
**Drive Initialization**: Drive Initialization provides access to a system feature that moves the drives and trim tabs throughout their range of operation to learn the sensor range values.

**Drive Alignment**: Drive Alignment provides access to a feature that performs an on the water and under power drive adjustments test needed to maintain a straight heading.

**Compass Configuration**: Compass Configuration provides access to any compass configuration settings required to setup or repair a Joystick Piloting vessel. The features within this section follow:
- Compass Calibration Wizard
- Compass Orientation
- Compass Linearization
- Clear Compass Compensation
- Auto Heading Offset
- Manual Heading Offset
- Validate Compass Configuration
**Merc TDS Reset:** The Merc TDS Reset configuration is used to pair key fobs to the Merc TDS (Theft Deterrent System) or remove the Merc TDS.

**Personality**

Personality (referred to as Import in previous versions of CDS G3) allows access to a function for importing a vessel specific file into a boat that contains calibrated parameters. (Example: boat length, center of gravity, or reverse drive efficiency.)

This screen also provides the ability to import and export gauge settings. These files are created by an OEM engineer. This feature applies to a Joystick Piloting system.
Diagnostics allows access to diagnostic functions that enable the user to perform operations like injector test, spark test, setting engine location, cylinder misfire test, etc. These tests are initiated by CDS G3, but are controlled by the ECM/PCM.

Set Trim Limit: This feature allows adjustment of the upper limit the drive can travel while under power. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the Configuration section.
Set Tilt Limit: This feature allows the user to set the maximum tilt up location from an ERC. Set Tilt Limit is controlled through the ECM and is only active at low RPM and when the engine or drive receives a trim request from the ERC. Setting a lower value than factory default is useful if there is an obstruction that would cause damage to an engine, drive, or boat component while trimming. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the Configuration section.

Set Engine Location: This feature allows the user to view or change the current engine location. Changing the engine location is necessary when setting up a multiengine boat. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the Configuration section.

Set Tach Link: This feature allows the user to configure the signal coming from the gray engine harness tachometer lead. This drives either an Analog Gauge Interface (AGI) or an SC100 System Link gauge. When Tach Link is enabled the gray tachometer lead does not output the analog tach signal. Instead, the PCM sends a digital signal that can be received by the Analog Gauge Interface (AGI) or SC100 System Link gauges, if the proper adapter harnesses are connected. To turn the Tach Link function OFF, select Disable. The gray engine harness tach lead once again outputs an analog tach signal. Tach Link only appears as an Active Test menu option if the function is supported by the selected engine's processor. Because this is a configuration feature, and not a test, this procedure will eventually be moved to the configuration section.
**Cylinder Misfire:** This test allows the user to isolate a problem for a particular cylinder. Select a cylinder and start the test to diagnose the engine; watch and listen for a reaction in the running of the engine to occur. No reaction would indicate a possible issue on that cylinder.

*NOTE:* On FourStroke, large horsepower engines it may be difficult to detect any noticeable RPM or sound changes when the misfire test is done at idle. If no obvious change is noticed, try to test again at another throttle position greater than zero percent or under load.

**Fuel Pump Output:** This test allows the user to test the fuel pump for mechanical activity. The test will not function if the engine is running.

**Idle Air Control:** This feature allows the user to test the functionality of the idle air control valve. The behavior of this test on a running engine will depend on the engine coolant temperature and idle control calibration in the ECM. Once the engine has reached its normal operating temperature the running test will allow you to apply a positive or negative offset to the base IAC set point. As you decrease the offset with a negative value the engine RPM should decrease. The engine idle control strategies may prevent you from exceeding allowable set points.
Horn Output: This feature allows the user to test the horn. Listen for the horn to sound during this test.

Ignition Spark: This test confirms the existence and strength of the spark.

Smart Start: This feature allows the test of the Smart Start system and allows the user to start and stop the engine from the CDS G3 program.
**Tach Output**: Used to validate that an analog gauge is calibrated properly and the ECU is driving the analog signal.

**Steering Override**: This test is used on Axius engines only and allows you to override the TVM drive position on an Axius Gen I or Axius Gen II system. You can set the drive position via a slider or select auto to begin a sine wave sequence for a short period of time. For Axius Gen I, the engine must be running to change the drive position. Axius Gen II systems have the option to override the drive position while the engine is not running.

**Injector Pulse**: This test confirms if an injector is actuating while installed in the engine.
**Auto Test:** This selection performs a series of tests to identify if any faults are generated. This test also energizes the ignition system to generate a spark as a starting point for diagnostics.

**Reflash**

Reflash allows a user to reprogram control modules.

- **Module Reflash:** This feature will take you into a guided process for reprogramming modules.
- **History:** This will allow the user to view all previously performed reflash events.

**Reflash Package Browser–Show All:** The browser displays a list of available reflash upgrades. The page file consists of specific modules that are allowed to be upgraded. The page also gives the user a wide variety of methods to sort and search the list of package files (e.g. date, category, service bulletin, etc.). When Show All is selected you will be shown the other selectable status, **Show Filtered**.
Reflash Package Browser–Show Filtered: When Show Filtered is selected, you will only be presented with reflash packages available for detected modules.

Reflash Package Browser–No Updates: If the modules detected have no reflash packages available, a notification is presented stating this. This is only available in the filtered view.

Reflash Prerequisites: These indicate the requirements that must be met for reflash to proceed. If you receive green check marks the requirements have been met. A red X indicates the prerequisite has not been met. A yellow exclamation point identifies a caution status. For details on each prerequisite, see the dedicated page under reflash in the help menu.
**Reflash Module View:** This view will show you the modules available from the selected reflash package. If the module is upgradeable this will be indicated by a lightning bolt icon. The topmost upgradeable module will be highlighted indicating the order in which to reflash. Up-to-date modules will be indicated by a green check icon. Modules that are in the package but that may have a wrong calibration ID, or missing information, will be indicated by a slashed circle icon. Modules that are conflicted (for example, more than one module on the same city ID) will be indicated by a red icon.

**NOTE:** Multiple engine/helm configurations may require a certain engine to be keyed off.

**Reflash–Serial Number/Hull ID:** This allows the user to input the information into CDS G3 for record keeping.

**Reflash Cautions:** This page warns you to be careful when reflashimg. It is important to make sure you disconnect all SmartCraft gauges, including VesselView, prior to reflashimg.

**Reflash Progress:** This page allows the user to monitor the progress of the reflash event. After a successful reflash, helm adaptation or set engine location may be required as determined by the package file. Perform the required steps and click close to be redirected to finalize the reflash session.

**Show Options**

These settings are accessed from the upper text menu by choosing **Options**. **Show Options** allows you to setup or change certain behaviors of the software. For instance, you could change the save location of the **Print Screen** function.

**CAN Hardware Settings:** This menu allows the user to configure the SmartCraft Diagnostic Interface.

**Data Record:** The Data Record settings allow you to change the location the application will place a recorded file and the CSV export file.

**Reflash History Directory:** This menu allows you to view and change the reflash history output directory where reflash reports will be saved.

**Screenshots:** This menu allows you to configure the print screen settings by changing its location.
**Units**: This function was released with version 1.4 software. It allows the user to change the units of measure on the live data screen. You can choose from English, metric, or custom, which allows you to customize your units of measure for each of the following: temperature, speed, volume, flow rate, and pressure.

**Connections**: This menu allows the user to enter proxy settings that may be required in order to access the internet in a managed network.  
*Automatic Updates* is defaulted with a blue check mark which requires you to be prompted to download the updates. The updates will be automatically installed without being prompted by deselecting the blue check mark.  
**NOTE**: For most dealerships proxy settings will not be used. Only enter information your network administrator provides. Entering incorrect information will prevent registration and updates from functioning.

**Language**: This screen allows the selection of foreign languages. It also allows you to set the Data List descriptions from standard to engineering terms.
Help Screen: The Help feature has been removed and the contents are now integrated into the user’s manual. The user’s manual is available in the Windows Start Menu, in the folder named Mercury Marine. The User’s Manual can also be accessed through the new literature feature. More information is available under the literature feature in this document.
Frequently Asked Questions

Section 6A - Frequently Asked Questions

Table of Contents

FAQs................................................................................................. 2
FAQs

Q: I am entering my dealer number and phone number correctly to register but I receive an error stating "Invalid Dealer".
A: CDS G3 requires your full dealer number and phone number. Verify you are entering these correctly.

Q: Is CDS G3 Windows 7 compatible?

Q: Is CDS G3 Windows 8 compatible?
A: CDS G3 version 1.5 and newer is compatible with Windows 8 Professional. Windows Professional 8.1 is required to take advantage of the new Literature feature.

Q: Is CDS G3 compatible with 64-bit operating systems?
A: Yes, version 1.2 was compatible but contained a bug which prevented the software from updating. This issue was corrected in version 1.4. All versions from 1.4 forward are fully compatible with 64-bit operating systems.

Q: Will CDS G3 work with Verado?
A: At this time, CDS G3 will work with Joystick Piloting for Outboards, including Verado. Older versions of Verado require CDS.

Q: What should I put in the proxy settings in options/connections?
A: Do not put anything in these fields unless specified by your network administrator. In most cases, a proxy is not used. If these fields are filled in incorrectly, communication to our servers for registration and updates will fail.

Q: My computer is going into hibernation and sleep mode?
A: Placing the computer in, or allowing the computer to enter sleep or hibernation mode while actively connected to a vessel using CDS-G3 results in the following complications upon resume:

- Application crashes and display of Windows crash popup.
- Loss of CAN data connectivity. Modules missing and data shown as dashes.
- SmartCraft Interface cable is no longer detected by the system.
- Incorrect CAN P/H indicator states (yellow,green,red).

Sleep is a reference to a mode the computer can enter which reduces power consumption. In sleep mode, the computer is still powered up. Resuming from sleep mode is relatively quick.

In comparison, hibernation mode will take this concept further and actually saves the current operations and shuts down the computer. Resuming from hibernation is a much longer process.

Both of these modes are most commonly triggered by a time setting, closing the lid on the laptop, or depending on the computer, briefly pressing the power button.

To avoid these issues, it is suggested to follow these best practices:

1. Unplug the Kvaser cable before entering hibernation or sleep.
2. Close the CDS-G3 application before entering hibernation or sleep.
3. Disable automatic hibernation or sleep when closing the lid or adjust the time setting to better fulfill user needs.
4. Disable power saving modes that automatically place computer in sleep or hibernation mode or adjust the time setting to better fulfill user needs.
5. Disable hibernation or sleep of USB devices (Advanced Power settings).

These are suggestions and are completely optional. Please be aware the merit of these features is to extend the duration of a battery charge, along with conserving power.
# Appendix

## Section 7A - Appendix

**Table of Contents**

<table>
<thead>
<tr>
<th>Section</th>
<th>Page</th>
</tr>
</thead>
<tbody>
<tr>
<td>SmartCraft Interface Driver Installation</td>
<td>2</td>
</tr>
<tr>
<td>Manual Driver Installation</td>
<td>2</td>
</tr>
<tr>
<td>Error Codes</td>
<td>2</td>
</tr>
</tbody>
</table>

<p>| | |</p>
<table>
<thead>
<tr>
<th></th>
<th></th>
</tr>
</thead>
<tbody>
<tr>
<td>Error Code 100</td>
<td>2</td>
</tr>
<tr>
<td>Error Code 101</td>
<td>2</td>
</tr>
<tr>
<td>Registration Errors</td>
<td>2</td>
</tr>
</tbody>
</table>
SmartCraft Interface Driver Installation

In versions prior to 1.4, we have noticed a high number of issues with the SmartCraft interface cable not working after a new installation. In version 1.4, we have addressed several issues to improve this process. If you experience a suspected driver issue, the key indicator is the green power LED on the SmartCraft interface cable is flashing. This likely means the driver is not associating with the hardware. Reference the following manual driver installation instructions. If the LED is a solid color, reboot your PC and try again.

Manual Driver Installation

To begin, make sure your SmartCraft interface is unplugged and CDS G3 is closed. Plug in the SmartCraft interface and watch the lower right corner for a new hardware found notification. Click on this notification to open the New Hardware Wizard. When asked if Windows can connect to Windows Update, select No, not at this time. The driver was already installed with CDS G3. On the next screen, select Install the Software Automatically. When finished, confirm the green power LED on the SmartCraft interface is no longer flashing. A reboot may be required.

Repeat this process for each USB port on your PC.

Error Codes

Error Code 100

The application has encountered an authentication error and must close.

Please contact Mercury Service for further assistance.

Error Code 100 occurs when something has changed on the PC that affects the registration file. This could include replacing a hard drive or motherboard, or changing the name of the PC.

Error Code 101

The application has encountered a system clock validation error and must close.

Please contact Mercury Service for further assistance.

Error Code 101 occurs when the system clock has been altered from the correct time and date. Check your time and date for accuracy. If your time and date repeatedly changes to a previous point and does not keep its setting after a reboot, the battery (frequently referred to as a CMOS battery) on the motherboard may require replacement.

Registration Errors

The following is a list of possible licensing and registration errors and what they mean.

ERROR: Dealer Number is not a valid length

This error occurs when the dealer number has three or fewer characters. Enter your complete dealer number to correct. U.S. and Canadian dealer numbers will be seven digits. In other countries, dealer numbers may be alpha numeric and as few as four numbers.
ERROR: Invalid Dealer
This error occurs when the entered dealer number is not found in the CDS G3 subscription database. Either the dealer has entered a wrong number or a subscription has never been issued to that dealer for any CDS G3 license.

ERROR: Invalid Subscription
The dealer number is in the CDS G3 subscription database, but a subscription for that specific version is not found. This error will occur if the dealer has a license for a different version of CDS G3. A license purchase for your dealership may be required. For questions related to licensing and invalid subscriptions, please contact Mercury Technical Service.

ERROR: Internet Connection Failed. Please verify you are connected to the internet.
This error occurs when CDS G3 cannot connect to the Server. This issue could be caused by several issues:

- **No internet connection available.** Confirm using your internet browser.
- **Communication is being blocked.** Possibly because of a firewall/router. Could be ISP.
- **Incorrect proxy entered.** Most dealers will not require a proxy. No information should be entered unless required and provided by their IT administrator. This can be reviewed by selecting Tools/Options/Connections.
- **Security certificate issue.** Confirm that the computer can connect to mercnet.mercurymarine.com. If not, the security certificate may need to be updated.
- **Usually computer is not updated.** Perform all "high priority" updates through Windows Updates.
ERROR: Inactive Dealer
The dealer number entered is no longer active with Mercury Marine.